Total Commander - Notepad - Paint -Firefox
Ezt a tananyagot innen lehet letölteni: http://szilagyidonat.hu/tananyag.html
Szerző: Szilágyi Donát
E-mail: donat_szilagyi@hotmail.com
1 Total Commander    [image: ]
A Total Commander innen tölthető le: http://www.ghisler.com/download.htm
1.1 Adattárolók
C: Winchester, a számítógépbe be van építve
D: DVD, CD
E: Pen drive (kiejtés: pen drájv)
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Egérrel vagy ALT F1 és ALT F2 segítségével lehet adattárolót váltani.
Ha mégse akarunk váltani, Esc gombbal lehet visszalépni. Általában mindenből Esc gombbal lehet visszalépni.
Feladat: Nézd meg, milyen adattárolók vannak, próbálj meg átváltani C: -ről egy másikra és vissza.

	
1.2 Könyvtárváltás
A Total Commander-ben sárga mappa és <DIR> jelöli a könyvtárakat.
Minden, ami nem könyvtár, az fájl. A fájloknak általában van kiterjesztésük, például: png.
A könyvtárakba dupla klikkel bele lehet menni. Könyvtárból kijönni a [..] –on duplaklikkelve lehet.
A C: a könyvtárszerkezet gyökere, onnan már nem lehet kijjebb jönni.
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Feladat: Menj be különböző könyvtárakba és gyere ki belőlük.


1.3 Fájlkiterjesztések
A fájl kiterjesztése az Ext oszlopban van. A Size (kiejtés: szájz) oszlop a fájl mérete byte-ban mérve. A Date (kiejtés: dét) oszlop a fájl utolsó módosításának ideje.
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Gyakoribb kiterjesztések:
Képek: bmp, png, jpg, gif
Szöveg (Notepad vagy Notepad++ nevű programmal szerkeszthető): txt
Formázott szöveg (Word nevű programmal): doc, docx
Formázott szöveg, csak olvasható (Adobe Reader nevű programmal): pdf
Web oldal (Firefox-szal nézhető meg, Notepad vagy Notepad++-szal szerkeszthető): html
Web oldal stílus (Notepad vagy Notepad++-szal szerkeszthető): css
JavaScript program (Notepad vagy Notepad++-szal szerkeszthető): js
Film (VLC media player-rel nézhető meg): avi, flv, mpg, iso, mkv
Zene: mp3, wav
Önmaguktól futtatható programok: exe, bat
Tömörített fájlok és könyvtárak: zip


1.4 Fájl megnézése, szerkesztése
Fájl kijelölése
Szürke keret jelöli azt a fájlt vagy könyvtárat, ami éppen ki van jelölve.
A billentyűzeten a fel és a le nyíllal tudod megváltoztatni a kijelölt fájlt. A bal és a jobb oldali panel között a Tab gombbal (Q –tól eggyel balra, oda-vissza nyíl van rajta) válthatsz.
De egy egérklikkel is kiválaszthatsz fájlt akár a bal, akár a jobb oldalon. Fontos, hogy nem duplaklikkel jelöld ki, mert azzal el is indítod a fájlt vagy bele mégy a könyvtárba.
Dupla klikk a fájlon
Vannak olyan fájlok is, amik dupla klikkel elindíthatóak: png, jpg, gif, txt, doc, rtf, html.
Ilyenkor egy program indul el, pl.: Paint, Notepad, Word, Firefox. És ez a program betölti a fájlt.
F3 View: (kiejtés: vjú) fájlba belenéz
A kijelölt fájl megnézésére használhatod a Total Commander-ben lévő F3 gombot vagy a billentyűzeten lévő F3 gombot is.
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Feladat: F3-mal nézd meg, mi jelenik meg, ha különböző kiterjesztésű fájlok vagy könyvtár van kijelölve.
F4 Edit: Fájl szerkeszt
A kijelölt fájl szerkesztése a Notepad nevű programmal. Szöveges fájloknál működik: txt, html, css, js.


1.5 Fájl másolása, mozgatása
F5 Copy: másol
A szürke kerettel kijelölt fájlt vagy könyvtárat másolhatjuk át a baloldalon lévő könyvtárból a jobboldalon lévőbe. De fordítva is ugyanígy működik, tehát a jobb oldalról is másolhatunk balra.
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Az új fájl nevét meg is változtathatjuk. Ekkor egyet klikkeljünk a kékkel kijelölt útvonalon, ami itt: c:\Donat\Cd\Domi\csillagos_eg.png. A könyvtárat ne írd át csak a fájl nevét, ami az utolsó \ után van. A pont utáni kiterjesztést se írd át. A fájl névben a billentyűzeten a jobbra, balra nyíllal mehetsz jobbra, balra. A Del gombbal pedig egy betűt törölhetsz.
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Nyomj egérrel az OK-ra.
Ha már létezik az a fájl vagy könyvtár a másik oldalon, amit a másolással létre akarunk hozni, akkor a Total Commander meg fogja kérdezni, hogy azt felülírja-e.
F6 Move: másol, de az eredeti helyről törlődik.
Ugyanaz, mint a másolás, csak az eredeti helyről törlődik a fájl vagy könyvtár.
Ha baloldalon és jobboldalon is ugyanabban a könyvtárban vagyunk, akkor fájl átnevezésére használhatjuk.
De fájlt átnevezni úgy is lehet, ha a szürkével kijelölt fájlra egérrel rákattintunk.
[image: ]


1.6 Új könyvtár készítése
F7 New Folder: új könyvtár csinál
Azon az oldalon (bal vagy jobb) legyen kijelölve valami, amelyiken az új könyvtárat akarjuk csinálni, és utána F7.
[image: ]
És létrejön a Hello könyvtár.
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1.7 Szöveges fájl létrehozása
Shift + F4
A shift gombot tartsd nyomva, és közben nyomd meg az F4 gombot.
A shift gombot baloldalt a Ctrl gomb fölött találod, egy felfele nyíl van rajta.
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Add meg a fájl nevét. Javasolt adni hozzá egy .txt kiterjesztést is, de nem kötelező.
Az OK megnyomása után a fájl Notepad-ban lesz szerkeszthető, erről nemsokára tanulni fogunk.
1.8 Alt + Tab
Két alkalmazás között, például Total Commander és Notepad úgy is válthatunk, hogy nyomva tartjuk az Alt gombot, és közben megnyomjuk a Tab gombot. A Tab gomb bal oldalt van, és egy balra meg egy jobbra nyíl van rajta.
De a képernyő alján a taskbar-on egérrel is válthatunk.
1.9 Fájl vagy könyvtár törlése
F8 Delete: töröl
A szürke kerettel kijelölt fájlt vagy könyvtárat tudjuk törölni.
Használhatjuk a Delete gombot is a billentyűzeten.
Törlés előtt a Total Commander megkérdezi, hogy biztosak vagyunk-e benne. Ha igen, akkor nyomjunk Yes-t, végül is mi baj lehet?
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Feladat: Hozz létre egy könyvtárat. Menj bele a bal vagy a jobb oldalon az új könyvtárba. Másolj bele egy fájlt az új könyvtárba. Törölt le a fájlt. Menj ki a könyvtárból. Töröld le a könyvtárat.


1.10 Mennyi hely van a winchesteren
· 1 byte (bájt) = 8 bit
· 1 kB (kilóbájt) = 1000 byte (bájt)
· 1 MB (megabyte) = 1000 kB
· 1 TB (terabyte) = 1000 MB
1 bit-be egy kétértékű adat fér bele, például 0 vagy 1.
1 byte-ba egy 0 és 255 közötti szám fér bele, a 0-t és a 255-öt is beleértve.
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Feladat: Nézd meg, mennyi hely van összesen a winchestereden, és abból mennyi szabad.
Segítség: A fenti ábrán 716 GB-os winchesteren 93 GB szabad hely van.


2 Notepad
[image: ]
Notepad segítségével készíthetünk szöveget tartalmazó fájlokat: txt, html, css, js.
A nem szöveget tartalmazó fájlokat, például png, gif, jpg, avi, mp3 bináris fájloknak is nevezzük.
Nyissuk meg a Notepad-ot.
2.1 Save, Save As: szövegfájl mentése
A Save As… (kiejtés: szév ez) segítségével tudjuk menteni a fájlt, amivel dolgozni fogunk. Érdemes rögtön ezzel kezdeni.
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Mentéskor be kell állítanunk a könyvtárat, amelyikbe menteni akarunk és a fájl nevét. A fájl név beírásakor a jobbra, balra nyilak és a Del (betű törlése) gomb is a segítségünkre lehet.
A könyvtárat és a fájlnevet együtt a fájl útvonalának is szoktuk hívni. Itt például a fájl útvonala ez lesz:
C:\Lena\hello.txt
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Miután sikerült beállítanunk a könyvtárat és a fájl nevét, nyomjuk meg a Save gombot a fájl mentéséhez.
A későbbiekben már nem kell újra beállítani a könyvtárat és a fájl nevet, simán a Save-vel is menthetünk.
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Ha a Notepad bezárásakor nincs minden elmentve, bezárás előtt megkérdezi, hogy mentsen-e:
[image: ]
Save: mentsen
Don’t Save: ne mentsen
Cancel: ne mentsen, de ne is lépjen ki Notepad-ból
2.2 Szövegfájl betöltése Notepad-dal
A File > Open segítségével tölthetünk be egy korábban elmentett szövegfájlt.
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A felugró ablakban ki kell választani a könyvtárat és a fájlt, majd rá kell klikkelni alul az Open gombra.
[image: ]



2.3 Szövegfájl betöltése Total commander-ből
Ezt már tanultuk: F4
2.4 Szöveg írása
Feladat: Írj valamilyen szöveget Notepad-ban.
Ha betűket vagy számokat írsz, kisbetűk és számok jelennek meg, például: dg53m9
Ha nyomva tartod közben a Shift-et (bal oldalt felfele nyíl gomb a Ctrl gomb fölött), nagybetűk és a számgombok feletti jelek jelennek meg: JD%=TZ+
Ha valamelyik gombon van jobb alul is valamilyen jel, azt az Alt Gr gomb nyomva tartásával lehet megjelenteni: Łß#&[ 
Szóköz: a hosszú gomb alul.
Soremelés: Enter gomb, jobb oldalt egy jó nagy gomb, ilyesmi jellel: ←┘
Betű törlése: Del gomb (jobb fent)
Mozgás a szövegben: nyilak (jobb lent)
2.5 Status bar
A View > Status Bar menüponttal lehet be- és kikapcsolni.
Alul jelzi, hogy hányadik sornál és oszlopnál tartunk.
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A Notepad-on ahány betűt, számot, jelet írunk le, mentés után Total Commander-ben körülbelül annyi byte lesz a fájl mérete. Egy normál betű, szám, jel 1 byte adatmennyiségnek felel meg. Van néhány bonyolultabb jel viszont, ami 2 vagy 3 byte helyet foglal el.
Feladat: Indítsd el a Notepad-et. Írj le néhány betűt, számot. Számold meg hány betűt, számot írtál. Mentsd el, amit csináltál Save As –zel. Válts át Total Commander-be. Keresd meg a fájlt, amit mentettél és nézd meg hány byte helyet foglal el.
Feladat: Gépelj tetszőleges szöveget Notepad-ba. Legyen benne soremelés, szóköz. Írj kisbetűket, nagybetűket, számokat. Próbáld ki a Shift-et és az Alt Gr-t is.


2.6 Kijelölés, másolás
Szöveg kijelölése egérrel: bal gombot lenyomva tartva az egeret kijelölendő szöveg fölött végighúzzuk.
Szöveg kijelölése billentyűzettel: tartsuk lenyomva a Shift gombot (Ctrl gomb fölött) és használjuk a nyilakat.
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A kijelölt szöveg másolása: Ctrl C, Ctrl V 
Jelöljünk ki szöveget. Tartsuk lenyomva a Ctrl gombot és nyomjuk meg a c gombot. Menjünk nyilakkal oda, ahova be akarjuk illeszteni a kimásolt szöveget. Tartsuk lenyomva a Ctrl gombot és nyomjuk meg a v gombot.
Ctrl C és Ctrl V helyett az Edit menü alatti Copy-t is használhatjuk másoláshoz és a Paste-et (kiejtés: pészt) beillesztéshez.
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Ha mindent ki akarunk jelölni, a Ctrl A -t használhatjuk, vagy menüből Edit > Select All.
Feladat: Save As-zel ments el egy txt kiterjesztésű fájlt. Írj bele egy több soros szöveg et. Jelölj ki egy sort. Másold le és illeszd be valahova. Illeszd be több helyre is. Save.
A Ctrl C, Ctrl V, Ctrl V elég sok helyen használható, nem csak Notepad-ban.


3 Paint
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3.1 Kép mentése
Indítsuk el Paint-et. Első alkalommal Save as menüponttal mentsünk. A menü a bal felső sarokban lévő kék háttéren fehér színű füzetecskére klikkelve jelenik meg. A PNG-t érdemes választani, az egy viszonylag modern képformátum.
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Válasszuk ki a könyvtárat, amibe menteni akarjuk a képet, és adjuk meg a fájl nevét. Nyomjuk meg alul a Save gombot.
A későbbiekben már elég lesz Save as helyett Save-vel menteni, ott már nem kell megadni könyvtárat, fájl nevet.
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Ha Paint-ből úgy lépünk ki, hogy nem mentettünk, a Notepad-hoz hasonlóan a Paint is megkérdezi, hogy mit csináljon:
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Save: mentsen
Don’t Save: ne mentsen
Cancel: ne mentsen, de ne is lépjen ki Paint-ből


3.2 Kép megnyitása Total Commander-ből
Ha már van egy elmentett képünk, azt Total Commander-ből úgy nyithatjuk meg, hogy egérrel a fájl fölé állva nyomva tartjuk a jobb egérgombot. Ekkor az Open with menüből a Paint-et választjuk.
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3.3 Kép megnyitása Paint-ből
Vagy Paint-ből is megnyithatjuk a képet az Open menüponttal. Esetleg ha a Recent pictures (legutóbbi képek) alatt megtaláljuk, akkor onnan is megnyithtjuk.
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3.4 Kép mérete
A képmérete alul látható. A 896 x 1608px azt jeleni, hogy a kép 896 pont széles és 1608 pont magas.
px = pixel = pont
Ha a kép mérete túl nagy, akkor a jobb oldalt vagy alul megjelenő csúszkával közlekedhetünk benne.
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A bal alsó sarokban azt láthatjuk, hogy az egér hány pixel távolságra van a kép bal oldalától, és hány pixel távolságra van a kép tetejétől.
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3.5 A kép méretének beállítása
Klikkeljünk a Properties menüpontra.
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A felugró ablakban válasszuk a Pixels-t, ami azt jelenti, hogy pontokkal adjuk meg a kép méreteit.
A Width után írjuk be, mennyi legyen a kép szélessége, a Height után pedig a magasságát. Végül klikkeljünk az OK-ra.
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Ha ügyesek vagyunk, észrevehetjük, hogy a kép jobb oldalán, az alján és a jobb alsó sarokban van egy pici fehér kocka, ha fölé megyünk egérrel és nyomva tartjuk a bal egérgombot, akkor az egér mozgatásával is átméretezhetjük a képet.
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3.6 Színek
Először válasszunk ki színt. Klikkeljünk a Color 1-re, majd tőle jobbra, arra a színre, amit be akarunk állítani tintaszínnek. Ha nem elég a 20 meglévő szín, akkor az Edit colors-szal csinálhatunk magunknak még tízet.
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Ha nem elég a 20 meglévő szín, akkor az Edit colors-szal csinálhatunk magunknak még tízet.
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A Color 1 az a szín, amivel a fehér területen bal egérklikkel rajzolhatunk valamit. A Color 2 színnel pedig jobb egérklikkel rajzolhatunk. Ha a Color 2-t meghagyjuk fehérnek, azzal törölni tudunk majd.
3.7 Rajzoljunk valamit
Feladat: A bal egér gombot nyomva tartva fessünk valamit. Gyorsabban megy, ha a Size (kiejtés: szájz) menüben vastagabbra állítjuk az ecsetet.
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Feladat: A jobb egérgombot nyomva tartva töröljünk bele a rajzunkba. A törlés Color 2 színnel fog történni.
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Feladat: Ha van kedved, próbáld ki a Brushes (ecsetek) helyett a Shapes (alakok, kiejtés: sépsz) közül valamelyiket. Ha végeztél, kattints újra a Brushes-ra.


3.8 színnel kitöltés, szín minta vesz
Feladat: Válasszunk ki Color 1-nek egy új színt. Majd a Brushes helyett jelöljük ki a festékes bödönt. Kattintsunk a képen egy olyan színű pontra, amit át akarunk színezni. A környező ugyanolyan színű pontok is át fognak színeződni.
[image: ]
Ha vissza akarunk váltani az eredeti színre, akkor a cseppentőt válasszuk, és klikkeljünk a képen egy olyan pontra, aminek a színére vissza akarunk állni.
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3.9 Felirat
[image: ]Az A -ra kattintva feliratot helyezhetünk el a képen.
Feladat: Fedezd fel önállóan a felirat készítés csínját-bínját.
3.10 Kijelölés, crop
A Select (kiejtés: szelekt) segítségével kijelölhetünk egy téglalap alakú területet a rajzon.
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Ha egérrel a kijelölt rész fölé megyünk, akkor a bal egérgomb nyomva tartása közben a kijelölt képrészletet arrébb mozgathatjuk.
A kijelölést gyakran arra szoktuk használni, hogy a nem kijelölt részeket teljesen megszűntessük. Ez a Crop segítségével tehetjük meg.
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Feladat: Jelölj ki a rajzon egy olyan területet, ahova már festettél valamit. Crop segítségével szabadulj meg a többi résztől.
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3.11 Undo, redo
Ha nem tetszik, amit csináltál, akkor a kék balra nyíllal visszavonhatod azt. Ezt Undo-nak hívják. Ugyanezt billentyűzetről a Ctrl Z segítségével is elérheted.
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Ha meggondoltad magad, és mégse akarod visszavonni, amit csináltál, akkor a kék jobbra nyilat használt. Ez az Undo-tól eggyel jobbra van és Redo-nak hívják. Billentyűzetről a Ctrl Y segítségével érheted el ezt.
Hasonlóan a Ctrl C, Ctrl V, Ctrl A -hoz a Ctrl Z is sok más programban is használható.
Feladat: Select -tel jelölj ki egy kicsi területet a képen, ahova rajzoltál is valamit. Ctrl C segítségével másold le, Ctrl V -vel illeszd be, menj fölé egérrel és a bal egérgomb nyomva tartásával húzd el a lemásolt képrészletet máshová.
Működik a Del gomb is. Azzal egy Select-tel kijelölt részt tudsz törölni.
Feladat: Próbáld ki a Del gombot is.
3.12 Nagyítás, kicsinyítés
Ha nagyon pontos rajzot akarsz készíteni, nagyítsd ki a rajzodat. Ezt a jobb alsó sarokban lévő + jel segítségével teheted meg. Később a – jellel tudod visszaállítani az eredeti méretre, vagyis 100%-ra a rajzot.
A kinagyított rajzon a Brushes (eset) helyett inkább a ceruzát érdemes használni.
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Feladat: próbáld ki a ceruza alatti radírt is.


3.13 Print Screen
Csukd be a Paint-et és nyiss egy Firefox-ot (kiejtés: fájöfoksz) vagy bármilyen más böngészőt, pl: Chrome, Internet Explorer. Az Internet Explorer-t IE-nek is szokták rövidíteni. Ezek az ikonjaik:
	[image: ]   Firefox
	[image: ]   Chrome
	[image: ]   IE


A böngésző egyébként angolul browser (kiejtés: brózer).
Navigálj a kedvenc weboldaladra. Méretezd át a böngésző ablakát egy kicsit kisebbre. Ezt úgy teheted meg, hogy a böngésző jobb alsó sarka fölé mégy egérrel, nyomva tartod a bal egér gombot és az egeret balra és felfelé húzod, majd a kívánt méretnél elengeded a gombot.
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Ezután nyomd meg egyszerre a következő három gombot: Alt  Fn  PrtSc
Az Fn és az Alt bal alul van, a PrtSc jobb felül.
Nyisd meg a Paint-et, majd Ctrl V (tartsd lenyomva a Ctrl gombot, majd nyomd meg a V gombot)
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Ezután Select és Crop segítségével ki tudod ollózni a képről azt a részletet, amire szükséged van, és Save as –zel el is tudod menteni magadnak.
Az Alt  Fn  PrtSc bármilyen ablakon működik, nem csak a böngészőn. Ha pedig a teljes képernyőt akarod lemásolni, akkor: Fn  PrtSc.

Firefox
[image: ]
Firefox helyett más böngésző is megteszi.
3.14 Böngésző típusok
Gyakoribb böngésző típusok: Internet Explorer, Firefox, Chorme, Opera. A programozók többsége Firefox-ot vagy Chrome-ot használ.
3.15 Internet protokolok
http: normál weboldal
https: normál weboldal, de titkosítva utaznak az adatok a gépünk és a weboldal között
file: saját gépünkön lévő, html kiterjesztésű fájlt nyitunk meg böngészőben
ftp, sftp: FTP szerverrel kommunikálhatunk, szükség van hozzá a gépünkön egy FTP kliens programra is, például: WinSCP. Akkor használjuk ezt a protokollt, ha egy távoli web tárhelyre akarunk feltölteni fájlokat, például egy weboldal fájljait.
3.16 HTML
A html kiterjesztésű fájlok a weboldalak leggyakoribb elemei. Ezek HTML nyelven írt parancsokkal díszített szövegfájlok.
Feladat: Total Commander és Notepad segítségével készítsünk egy html kiterjesztésű fájlt, például: hello.html. Csinálhatjuk Shift F4-gyel Total Commanderből, vagy csinálhatjuk a Notepad megnyitása után Save As-zel. Notepad-ban írjunk a fájlba tetszőleges szöveget, majd mentsük el. Alt Tab-bal váltsunk vissza Total Commander-be, keressük meg a frissen készített html fájlt és duplaklikkel indítjuk el. A html fájl tartalma az alapértelmezett böngészőben fog megjelenni.
Feladat: Írjunk a HTML fájlba Notepad-dal több soros szöveget. Vegyük észre, hogy a böngészőt ez nem fogja meghatni, egy sorban jeleníti meg a szöveget. A <BR> paranccsal tudjuk HTML-ben több sorba törni a szöveget. Például írjuk be az alábbi szöveget: szia<BR>mia
A HTML parancsokat mindegy, hogy kisbetűvel vagy nagybetűvel írjuk, a <br> és a <BR> ugyanaz.
3.17 Az utolsó trükk
A böngészőkben is van menü, csak általában nem látszik, többnyire az Alt gomb megnyomásával csalogatható elő.
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